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Introduction

Background

NASA requires that all documents uploaded to NSPIRES are in Portable Document Format (PDF).
Standardizing on PDF allows NASA to deliver these documents to peer reviewers in a format that is
independent of any operating system, and can be viewed by users of Microsoft Windows, Apple OS X, and
various versions of UNIX.

It is essential that all PDF files generated and submitted meet NASA requirements. This will ensure that
the submitted files can be ingested by NSPIRES regardless of whether the proposal is submitted via
NSPIRES or Grants.gov. PDF files that do not meet NASA requirements cannot be ingested by the
NSPIRES system; such files may be declared noncompliant and not submitted to peer review for
evaluation. Ata minimum, it is the responsibility of the proposer to ensure that all PDF files are unlocked
and that edit permission is enabled; and to ensure that all fonts are embedded in the PDF file.

Uploading unlocked PDF documents (i.e., document with no security features enabled) is necessary to
allow NSPIRES to assemble the various submitted files together, along with data entered into the NSPIRES
proposal cover page (or, for Grants.gov users, the SF424 R&R and related forms) into a single PDF
document. This single document can then be more easily accessed by NASA Program Officers and peer
reviewers. Embedding all fonts in the PDF document, and using only Type 1 or TrueType fonts, helps
ensure that reviewers will see the proposal document as the proposer intended it to be seen, with all of the
proper fonts.

Following the guidelines included in this document will help ensure that PDF documents uploaded as part
of your research proposal will meet NASA requirements.

Purpose and Scope

This document provides instructions to users that are planning to submit research proposals to NASA on
how to prepare PDF documents for attachment to their proposal.

Intended Audience

This document is intended for anyone that will prepare and attach documents to a research proposal to be
submitted to NASA via either NSPIRES or Grants.gov.

References

You should always refer to the NASA solicitation to which you will submit a proposal for program-specific
information and document preparation instructions. In addition, the following references and guides will
be useful:

NSPIRES Tutorials: Online NSPIRES tutorials that cover the complete range of NSPIRES functions,
including uploading proposal documents, can be found at http://nspires.nasaprs.com/tutorials/index.html.
NSPIRES tutorials use Adobe Flash technology, which can be downloaded for free from Adobe at
http://www.adobe.com/products/flashplayer/.

Guidebook for Proposers Responding to a NASA Research Announcement (NRA): This Guidebook
describes the policies and procedures of the Broad Agency Announcement known as the NASA Research
Announcement (NRA) used by the program offices at the Headquarters of the National Aeronautics and
Space Administration (NASA) that solicit proposals for basic science and technology research. All
applicants who plan to respond to an NRA released by NASA Headquarters should adhere to the guidelines
contained in the main Chapters and Appendices of the NASA Guidebook for Proposers, unless otherwise
noted in the NRA itself. The NASA Guidebook for Proposers can be downloaded in PDF and MS Word
formats at http://www.hq.nasa.gov/office/procurement/nraguidebook/. Be sure to check the specific
solicitation to which you are responding to ensure that you follow the correct version of the NASA
Guidebook for Proposers.
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15 Getting Assistance with PDF Generation

For assistance with creating PDF documents on your computer, check with your local desktop system
administrator or with the vendor of the PDF software you are using. For clarification on the guidelines and
recommendations contained in this document, contact the NSPIRES Help Desk at:

Telephone: 202-479-9376

Email: nspires-help@nasaprs.com
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Creating PDF Documents

It is important that proposers create PDF documents that meet NASA formatting requirements. Proposals
often contain images, graphics, equations, and various character sets (e.g., Greek letters and symbols). To
enable peer reviewers and NASA staff to read your file as you intend it to read, your PDF file must be
complete and properly formatted. This means that it must contain embedded in it all the non-standard font
characters that you used when creating your proposal.

If you use UNIX or LINUX, you may use TeX/LaTeX technology to format text, which doesn't always
work with the Adobe PDF technology. To avoid these potential issues, NASA suggests that TeX/LaTeX
users should convert their Tex documents to DVI files, and then to PostScript and PDF when working on a
UNIX machine. See Section 4.4, Generating PDF Files from TeX and LaTeX for more information.

Note: To ensure your PDF files meet NASA formatting requirements, please make sure that all
security permission for your PDF files are set to No Security before you upload your PDF file to
NSPIRES. Failure to do so causes problems with the viewing and printing of your proposal.
Uploaded proposal PDF documents that have security permissions enabled are non-compliant, and
the proposal may not be considered for funding. See Section 5, Problems to Avoid.

Software Requirements for Creating PDF Files

The following software is acceptable for creating PDF files that meet NASA formatting requirements,
when the guidelines contained in this document are followed (see Section 3, Ensuring That Your PDF Files
Meet NASA Formatting Requirements):

e Adobe Acrobat Professional or Standard Version 5 or higher
e  Adobe Acrobat Distiller

e  Ghostscript (\Version 6.5 or higher)

o TeX/LaTeX

See Section 5, Problems to Avoid for information on software and settings that will not properly generate
PDF documents that meet NASA requirements.
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Ensuring That Your PDF Files Meet NASA Formatting Requirements

To ensure your PDF files meet NASA formatting requirements, you should take these measures, as
explained in this section.

Select Edit and Print Adobe Security Permissions
See the File = Document security option in Adobe Acrobat and set the following two security permissions
to Allow:

e Edit permission
e  Print permission

The Edit permission must be set to Allow so that NSPIRES can concatenate your documents into a single
file for access by NASA Program Officers and peer reviewers.

Embed All Fonts

Always embed fonts into the PDF file. Otherwise, PDF viewers and printers may replace your fonts with
substitutes and produce unwanted results. For example, a bracket in a mathematical equation might be
replaced by a column of letters. The proposer is responsible for ensuring that all necessary fonts are
embedded and that the resulting PDF document can be viewed and printed by NASA and its peer
reviewers. Proposals that cannot be properly viewed and printed may be downgraded during the evaluation
process, and may be returned for non-compliance.

Use Type 1 or TrueType Fonts
These fonts are commonly available in most applications.

Subset Fonts

For all applications other than TeX or LaTeX, subset fonts at a threshold of 100%. Subsetting fonts forces
the fonts you used to be properly called when individual PDF files are combined into one large PDF
proposal file.

Check Resolution for Figures and Images

Conversion programs to PDF have settings that may affect the resolution of your figures and images, so
you should verify that the resulting PDF document will be displayed as you intend.
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4.1

Generating PDF Documents

To generate a PDF file, use the instructions below for the appropriate software, version, and operating
system (OS):

e Microsoft Windows with Adobe Acrobat Professional or Standard Version 5 or higher
e Apple OS X
e  Ghostscript
e TeX/LaTeX

Generating a PDF Document in Windows

To generate a PDF document, you must have installed Adobe Acrobat Standard or Professional Version 5
or higher. You must also embed the fonts used in your word-processing document in the PDF file. The
following sample instructions for converting a PDF document on Windows XP Professional were created
using MS Word 2003 and Adobe Acrobat Standard 6.0. Depending on the software application used, and
the version of Windows and Adobe Acrobat, specific instructions for your computer may differ.

1. Open the document you want to convert to PDF.
2. Select File = Print. The Print dialog box is displayed (see Figure 4.1.1).

3. In the Name box, select Adobe PDF (for Acrobat Version 6 or higher) or Acrobat Distiller (for
Acrobat Version 5).

Print 2X
Printer
Name: ‘s Adobe FDF |
Status: Idle Find Printer...
Type: Adobe PDF Converter
Where: My Documents |:| Print to file
Comment: Creates Adobe PDF [ manual duplex
Page range Copies
@ al Number of copies: 1 :
() current page () selection

1

Enter page numbers and/or page ranges separated
by commas. For example, 1,3,5-12

() Pages:

1 Collate

Zoom

Print what: | Document v |
; : Pages per sheet: |1 page ¥
Frint: All pages in range e
Scale to paper size:  |No Scaling v‘
o J[ o

Figure 4.1.1: Windows Print Dialog Box
4. To ensure that your document will not have any security features, and that fonts will be embedded in
the PDF document, click on Properties in the Print dialog box.
5. Click on the Adobe PDF Settings tab (See Figure 4.1.2).
a.  Under the Adobe PDF Settings section, choose None for Adobe PDF Security.
b. Click on the Edit button for Default Settings.

Page 7 of 16




NSPIRES User Guide Version: 1.1

PDF Guidelines Date: 2/15/2007

% Adobe PDF Document Properties

Layout|| Paper/Quality | [E] Adobe PDF Settings

Adobe PDF Page Size: |Letter ﬂ
Adobe POF Conversion Settings

Default Settings: |Stamdard ﬂ

Use these settings to create PDF documents suitable for reliable viewing and printing of
business documents. The PDF documents can be opened with Acrobat and Reader 5.0
and later.

Adobe PDF Security: |Nc|ne ﬂ

v View Adobe PDF results

[v' Promptfar Adobe POF filename
[v Add Document Information

[v Do notsend fonts to "Adobe PDF"
[v Delete log files far successful johs

[ Askio Replace existing FDF file

[ OK } l Cancel

Figure 4.1.2: Adobe PDF Document Properties

c. Edit the PDF Default Settings.

i. On the General tab, we recommend choosing Acrobat 5.0 (PDF 1.4) for the
Compatibility setting (see Figure 4.1.3).

Standard - Adobe PDF Settings [g‘

General ]Images} Fonts I Calor ]Advanced}

Description

Use these seftings to create PDF documents suitable for reliable viewing and printing of
business documents. The PDF documents can be opened with Acrobat and Reader 5.0

File Options
Compatibility: |Acrobat 5.0 (FDF 1.4) |
Object Level Compression |Tags only ﬂ
Auto-Rotate Pages: |CoHectlvely by File ﬂ
Binding: |Leﬂ j

Resolution: |600 dots perinch
® All Pages

(" Pages From: To

[~ Embedthumbnails
[v Optimize for fastweb view

Default Page Size

Width: |612.0 Units: |Points ﬂ
Height |792.0

Save As | Cancel | Help
Figure 4.1.3: Adobe PDF Settings General Tab

ii. Click on the Fonts tab (see Figure 4.1.4).
1. Be sure the Embed all fonts checkbox is checked.

2. Be sure the Subset embedded fonts, and that 100 is entered in the % field.
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Standard - Adobe PDF Settings @

General} Images Fonts WCo\or ]Advanced}

[v Embed all fonts

[v Subsetembedded fonts when percent of characters used is less than: ’W 32
When embedding fails: |Warn and continue ﬂ
Embedding

Font Source: Always Embed

|CA\WINDOWS\Fonts) |
~

lAcademyEngravedLetPlain

lAgencyFE-Baold
lAgencyFB-Reg

Alba

AibaMatter

AlbaSuper

lAlgerian .

lArial-Black Never Embed:

Wrial-Blackltalic Arial-Black ~
|Arial-BolditalicMT Arial-Blackltalic

lArial-BoldMT Arial-BolditalicMT =
WArial-talicMT Arial-BoldMT

WArialM T AriaHtalicMT

WArialNarrow ArialMT

WArialNarrow-Bold ArialNarrow

ArnalMNarrow-Bold

|4

WrialNarrow-Boldltalic

152

AddName.. | |

Save As... | Cancel | Help

Figure 4.1.4: Adobe PDF Settings Fonts Tab

iii.  1f you make any changes to the default settings, click OK. You will be prompted to
save the default settings. If you prefer, you can save these settings as a separate file
for NSPIRES.

d. Click OK to finish editing the Adobe PDF settings.

6. Inthe Print Dialog Box, click OK. The Save PDF File As dialog box will be displayed. Give the file
a name and select the directory in which you want to save the PDF document.

7. Click Save.

8. Adobe Acrobat will generate the PDF document, and will automatically display the resulting PDF
document in an Acrobat window.

Your original document is now in PDF with fonts embedded, and is ready to be uploaded to NSPIRES or
attached to your Grants.gov application.

4.2 Generating a PDF File on Macintosh OS X

To embed the fonts in your document, NSPIRES recommends that you first turn a Word or other word-
processing document into a PostScript file and then convert the PostScript file to a PDF for uploading to
NSPIRES. The following instructions are for Mac OS X versions prior to 10.4.

1. Open your word-processing document.
2. Select File = Print.
3. Inthe dialog box, change Copies and Pages to Output Options (see Figure 4.2.1).
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Print

Printer: " jupiter.nasaprs.com '%]

Presets: | Standard _"e'!

———| v Copies & Pages
Layout

Qutput Options
Scheduler
Paper Handling
ColorSync
Cover Page
Error Handling
Paper Feed
Image Quality
Microsoft Word
Printer Features
Summary

1 @ Collated

numbers and/or
pag ges separated by
] Show Quick Preview commas (e.g. 2, 5-8)

{ page Setup... )

@ (Freview) (SaveA; PDF,,) ( Fax... ) @ ‘

Figure 4.2.1: Print Dialog Box

4. Click Save as file. The Save As box displays.

5. In the dropdown menu, select PostScript (see Figure 4.2.2).

Print

i : Y
Printer: | jupiter.nasaprs.com

Presets: | Standard

®E

( Output Options

# save as File Format| v PDF _:
PostScript
T

(3)  (Preview ) (SaveAsPDF..) ( Fax.. ) (save)

Figure 4.2.2: Select PostScript

6. Click Save.

7. Close the word-processing file.

8. Double-click the PostScript file icon or filename in the folder that you saved it to. A box displays
stating the PostScript file is being converted to PDF. When the conversion is finished, the converted
document displays as a Preview.

9. Inthe Preview, select File > Export (see Figure 4.2.3).
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B é Preview Edit View Co Tools Window Help

ene New From Clipboard 3N F(1 Page) (=]
. Open... #O0 | — — P
" ( | + - ( =a|
E - " Open Recent > | \‘2\ “2\ + A D)
Drawer Back/Forw ¥n Zoom In  Zoom Qut Tool Mode
— Close HEW —
Save BT =
Save As... 1+ 38S 1
;
1€ page Setup... 1+ 38P :
Print... %P |
|
?
Figure 4.2.3: Exporting a PostScript File to PDF
10. In the Format drop-down box, select PDF (see Figure 4.2.4).
Save As: Document4.jpg [a] ¢
[«») [E1m) ([ test -]
3 Network N &| Darte Modified
=} Macintosh HD
@ SMD
#E Desktop
4 skeddie
A Applications
4 Documents
& Music
1 Pictures | BMP
P2 i
Formati v JPEG ( Options...
MacPaint
[ Hide Extension @
Photoshop .

11. Click Save.

PICT

PNG

QuickTime Image

5GI

TGA

TIFF
b

Figure 4.2.4: Exporting to PDF

Your original document is now in PDF with fonts embedded, and is ready to be uploaded to NSPIRES or
attached to your Grants.gov application.

4.3

Generating PDF Files Using Ghostscript

Instructions and the current version of Ghostscript may be found at the GhostScript home page at
http://www.cs.wisc.edu/~ghost/. Go to the Ghostscript website for more information on converting

PostScript files to PDF documents.

Remember when using Ghostscript to:

o Use Type 1 fonts.

Page 11 of 16



http://www.cs.wisc.edu/~ghost/

NSPIRES User Guide Version: 1.1

PDF Guidelines Date: 2/15/2007

4.4

44.1

442

44.2.1

4422

e Embed all fonts.
e Set the output resolution at a sufficient level for your included images and graphics.
e Since ps2pdf will convert your PostScript file to PDF within Ghostscript, the following settings
are recommended:
0 dMaxSubsetPct = 100
0 dCompatibilityLevel =1.2
0 dSubsetFonts = true
o dEmbedAllFonts = true

Generating PDF Files from TeX and LaTeX

Properly generating PDF files from TeX and LaTeX that are compatible with NSPIRES may require
several steps, depending on the TeX distribution you are using. We recommend using TeX Live
(http://www.tug.org/texlive/) which makes generating PDF documents easier, and which seems to result in
PDF documents that meet NASA requirements. If you are using other TeX distributions, you may need to
follow several steps to generate a DVI file, PostScript file, and then PDF files.

Generating a PDF File Using TeX Live

To generate a PDF document from a TeX or LaTeX file, use the ps4pdf command, as shown in the
following example:

% ps4pdf sample.tex
This will result in a PDF document that can be uploaded to NSPIRES.

Generating a PDF File using Other TeX Distributions

If you are using other TeX distributions, you will need to follow several steps, as explained in the following
sections. These steps, in order, are to:

1. Generate a DVI file
2. Create a PostScript file from the DVI file

3. Generate a PDF document from the PostScript file.

Generate a DVI File
To generate a DVI file from a TeX file, use one the following UNIX commands:

1. For a plain TeX file use the command:
% tex sample.tex
2. For a TeX file using LaTeX use the command:

% latex sample

Note: The examples shown above will create the DVI file sample.dvi.

Create PostScript Files with TeX/LaTeX

Now that you have created your DVI file, you need to convert it to PostScript. Make sure that you have a
recent version of TeX (we recommend MikTeX if you are not using TeX Live) and that Type 1 fonts are
installed.

The following example shows the UNIX command that will generate the PostScript file, sample.ps:

% dvips -Ppdf -t letter sample.dvi
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In the above example, the following options are specified:

e The -Ppdf option tells "dvips" to generate the PostScript file with options for converting to PDF.
Otherwise, you will likely get bad fonts in your PDF document.
e The -t attribute says to explicitly use letter size paper as required.

Note: If your figures use PostScript that cannot be distilled to a PDF file, the conversion will fail.
Many applications that produce PostScript output do so imperfectly. Try converting the output to
some other format (preferably a raster/bitmap format) and then converting it back to PostScript or
Encapsulated PostScript. This can be done with an image manipulation program, such as Gimp
(http://www.gimp.org/).

4.4.2.3 Generate a PDF Document from PostScript Files

Convert the PostScript file to PDF using Adobe Distiller or Ghostscript. Other options may also exist, but
strictly compliant PDF files may not always result.

After generation, check your PDF for the following:

e It does not contain Type 3 fonts.
e It meets PDF specifications.
o All fonts are embedded.

There are two common problems with this approach to converting TeX documents to PDF:

o DVI-to-PS converters use, by default, bitmapped (Type 3) fonts. These fonts are fine for most
PostScript printers, but the resulting PDF files are difficult to read when viewed on a monitor.

e  Users who have access to PostScript (Type 1) fonts and understand how to get them into their
PostScript files may still be using an older version of Ghostscript. Prior to Ghostscript 6, fonts
could not be embedded.
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5.2

Problems to Avoid

Do Not Use Adobe Acrobat Encryption or Security Settings

Newer versions of Adobe Acrobat allow users to control the security settings of PDF files. Adding security
to PDF proposal documents submitted to NASA, either through NSPIRES or Grants.gov, will prevent
NASA from assembling the proposal cover page data and the various proposal documents into a single
PDF document. This will prevent NASA Program Officers and peer reviewers from accessing and viewing
your proposal. Therefore, NASA requires that all PDF documents submitted to NASA, through either
NSPIRES or Grants.gov, have no security features enabled.

To turn off Adobe Acrobat security settings, in a PDF document, perform the following steps:

1. Select File > Document Properties. The Document Properties box displays (see Figure 5.1.1).
2. Inthe left sidebar menu, select Security.

3. Inthe Security Method box, select No Security.

4. Click OK.

Document Properties E]

Advanced Document Security
Custom

The document's Security Method is used to restrict what can be done to the document. To
Description remove security restrictions set the Security Method to 'No Security'.

Fonts
Initial View

Security Method: fNU Security v

Can be Opened by:  All versions of Acrobat

Document Restrictions Summary
Printing:  Allowed
Changing the Document:  Allowed
Document Assembly:  Allowed
Content Copying or Extraction:  Allowed
Content Extraction for Accessibility:  Allowed
Commenting:  Allowed
Filling of form fields:  Allowed
Signing:  Allowed

Creation of Template Pages: Allowed

Figure 5.1.1: Setting PDF Document Security

Do Not Use These PDF Producers

The following PDF producers may generate accurate standalone documents, but in NSPIRES these
documents have one of the following problems:

e They cannot be easily concatenated with PDF files created by other producers, and cannot be
concatenated with the NSPIRES Proposal Cover Page.

e The embedding of fonts in PDF format is problematic and leads to distortion.

e The resulting concatenated PDF document may not be properly viewable by peer reviewers who
will be evaluating the proposal.
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5.2.2

523

524

NASA strongly recommends that you do not use the following PDF producers:

Canvas/Deneba PDF Filter
Dvipdf(m)

PDFWriter

FrameMaker

Ghostscript versions prior to 6.5
Hewlett-Packard Intelligent Scanners
Adobe PhotoShop

PStill

The following sections explain some of the problems these producers generate, and contain
recommendations for how to fix the problem if you have no alternative but to use one of these PDF
producers.

Canvas/Deneba PDF Filter
Problem: Concatenation.

NSPIRES has encountered significant difficulties when attempting to concatenate PDF files produced with
the Deneba PDF filter with other PDF files.

Possible Solution: Re-distill the file with Adobe Acrobat or Ghostscript.

When PDF files produced with the Deneba PDF filter (usually created by Canvas) are re-distilled with
Acrobat or Ghostscript, NSPIRES can usually concatenate the resulting files.

Dvipdf(m)

Problem: Concatenation.

NSPIRES has encountered significant difficulties when attempting to concatenate PDF files created by
dvipdf(m) with other PDF files, including the NSPIRES Proposal Cover Page.

Possible Solution: Convert the DVI files to PostScript, and then to PDF.

PDFWriter
Problem: Garbles or gobbles text.

PDFWriter does not produce acceptable PDF files, except under very limited circumstances. The danger is
that NASA Program Officers and peer reviewers will see garbled and/or incomplete versions of the
proposal.

Possible Solution: Use a supported PDF producer. It is recommended that you use Adobe Distiller (in the
same package as PDFWriter) or Ghostscript.

For more information on:

e  PDFWriter, go to: http://www.planetpdf.com/planetpdf/pdfs/issue02.pdf
e  GhostScript, go to: http://www.cs.wisc.edu/~ghost/

Adobe FrameMaker
Problem: Concatenation.

Even though FrameMaker is an Adobe Product, the "Save as PDF" option produces PDF files that
NSPIRES has difficulty accepting because that option uses the PDFWriter drivers. PDFWriter produces
PDF files that are difficult to concatenate.

Possible Solution: Convert to PostScript and then to PDF.
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525

5.2.6

5.2.7

5.2.8

If you have created a document in FrameMaker, choose File = Print, and check the Print to File option.
This procedure will not send a document to a printer, but it will save a file to the location that you specify
as a PostScript (.ps) file. Then you can use Acrobat Distiller or Ghostscript to create the PDF files from the
PostScript file.

GhostScript Versions Prior to 6.5
Problem: Difficulties with font embedding.

NSPIRES can only accept PDF files produced by GhostScript versions 6.5 and higher, since earlier
versions had difficulties with font embedding.

Possible Solution: Download the most recent versions of GhostScript and GSView (a Ghostscript GUI)
from Ghostscript from http://www.cs.wisc.edu/~ghost/.

Hewlett-Packard Intelligent Scanners
Problem: Files cannot be uploaded.

The Save as PDF feature on HP Intelligent Scanners produces PDF files that cannot be uploaded into
NSPIRES.

Possible Solution: Save file as JPEG file. Use the following recommended steps:
1. Use the Save As feature of the scanning software to save the document as a JPEG file.

2. Import this .jpg file into word processor software (e.g., Microsoft Word or Corel WordPerfect). It is
important to Import or Insert the picture file into the word processing document rather than using the
Cut and Paste options.

3. Save the file as a word processing file.

4. Convert your word processing document to PDF as you would with other word processing documents.

Adobe PhotoShop
Problem: Concatenation.

Even though PhotoShop is an Adobe Product, the Save as PDF option produces PDF files that NSPIRES
has difficulty accepting, because the option uses the PDFWriter drivers. PDFWriter produces PDF files
that are difficult to concatenate.

Possible Solution: Save file as JPEG file. Use the following recommended steps:
1. Choose File = Save As, and save the image as a JPEG file.

2. Import this .jpg file into word processor software (e.g., Microsoft Word or Corel WordPerfect). It is
important to Import or Insert the picture file into the word processing document rather than using the
Cut and Paste options.

3. Save the file as a word processing file.

4. Convert your word processing document to PDF as you would with other word processing documents.

PStill
Problem: Concatenation.

NSPIRES has encountered concatenation errors with files produced by the PostScript to PDF converter
PStill.

Possible Solution: We recommend that you use Acrobat Distiller or Ghostscript to create the PDF file from
the PostScript or Printer file.
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